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Night Owl
HD CMS (PC)

Night Owl
HD CMS (MAC)

Introduction
Night Owl’s HD CMS software is a powerful management tool which allows you to 
control and monitor as many as 100 Night Owl DVRs from a single location . The 
software allows you to adjust settings, control a PTZ camera, playback and save 
recorded video directly to your PC or MAC and view live video feed . For residential 
and business customers alike, the ability to view and manage up to 128 camera 
channels at one time offers invaluable peace of mind .

Getting Started
System Requirements
PC: Windows® XP, Windows® Vista, Windows® 7, Windows® 8 and Windows® 10
MAC: MAC OS® X, 10 .7 and above

Internet Connection Speeds
The required minimum internet connection speed is 2Mbps download and 2Mbps 
upload . Keep in mind this applies to the internet connections at the location of 
the DVR and the location of the computer you are monitoring / viewing . If you are 
monitoring multiple DVRs, your computer’s bandwidth requirements will increase 
if you wish to monitor a large number of channels simultaneously . You can check 
the speed of your internet connection by visiting www.SpeedTest.net from both a 
computer connected to the same network as the DVR and also the computer you 
will be using remotely .

Compatible Night Owl Security Systems
The following Night Owl Series can be accessed via the Night Owl HD CMS 
software:

• F6
• F9
• AHD7
• AHD10
• NVR10

*Any subsequent “Bundled” models deriving from any of these series.
*Keep in mind you must configure each DVR to the software before viewing.

How Do I Download 
Night Owl’s HD CMS Software?
In order to download software, go to www.nightowlsp.com and search for Night 
Owl HD CMS software for either your PC or MAC . Please temporarily disable all 
Antivirus programs so the software can be fully configured . Additionally, the Night 
Owl HD CMS remote viewing software can also be uploaded via the included 
software installation disk .

*If you previously installed Night Owl’s Surveillance Client Software on your PC or 
MAC, you will be prompted to remove it before Night Owl’s HD CMS Software can 
be successfully installed.

1 . Please keep in mind you may see 
a similar window appear if you 
have not disabled all Antivirus 
software . Click “Run” to proceed 
to the next step .

2 . For optimal functionality during 
the initial setup, be sure to 
close all other programs before 
beginning to install the software . 
Click “Next” .
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3 . This window will allow you to 
select the location to install the 
HD CMS software . By default the 
software will install in the Program 
Files folder on your computer, but 
you may click “Browse” to select 
another destination . Once you 
have made your selection, click 
“Next” .

4 . This window will allow you to 
configure the location of shortcut 
icons in the Start menu . Click 
“Next” to proceed .

5 . This window will allow you to 
select if you would like a desktop 
and / or quick launch icon . Click 
“Next” to proceed . 

6 . The software is now ready to 
install . Click “Install” to proceed .

7 . This window will display a 
progress bar as the software is 
installed to your PC or MAC . If you 
click “Cancel” from this window 
the installation process will be 
cancelled .

8 . When the software installation is 
complete, you will click “Finish” 
to proceed .

9 . If you have not disabled the 
Antivirus software on your 
computer, you may encounter 
similar windows while trying to 
open the software . 

Night Owl HD CMS Guide How to Download Software
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How Do I Add a Device to  
Night Owl’s HD CMS Software?
Once the Night Owl HD CMS software 
has finished downloading to your PC/
MAC, the Setup Wizard should launch . 
Click on “Next” .

Within the Setup Wizard, there are two 
methods which can be used to add a 
device to the HD CMS software: “Add 
Online Device” and “Add Device” . 

1 . Within Setup Wizard click on 
“Add Online Device” . 

2 . As long as your device is 
connected to your router, you 
will see it appear .

3 . Click on your device and then 
the menu to the right will 
populate with information .  
Click on “Add Selected Device” .

*Please keep in mind that a device can be added at any time by clicking on 
Help then Open Wizard or by going to the Group Device Management icon. The 
following steps will apply regardless of when device is added.

Add Online Device

4 . Verify that information is correct 
and then click on “Add” .

5 . You should see your device in the 
add screen . Once the lights turn 
green, click on “Import” to add 
your device to groups . 

6 . Click on “Modify“ to change your 
device name (if desired) . 

7 . The device should now be added 
to your HD CMS software . Click on 
“Finish” to exit Setup Up Wizard . 

Night Owl HD CMS Guide How Do I Add a Device to Night Owl’s HD CMS Software?
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Device Name: Choose any name you desire  
(32 character max .) .

IP/ID: Enter your P2P ID .

Media Port: Enter Media Port number,  
which is most often 9000 . 

User Name: Enter the user name of your DVR or NVR .

Password: Enter the Password of your DVR or NVR .

Channels: This field will automatically populate once you select the Add tab .

Add: Please be sure to select this tab to add the DVR or NVR .

Cancel: Select this tab to cancel adding a device .

Once you have added the device (DVR or NVR), red dots will appear next to the 
image of the added device .

After clicking on “Add Device” you will be directed to this screen . If you have 
configured the Night Owl HD app on your smart device, you will use that same 
information to populate the fields you see . If not, you will need to access your 
DVR/NVR directly, go to the Main Menu, then system, then info . There, you will 
see the needed information . 

Add Device
Night Owl recommends downloading and configuring your Night Owl HD 
application on your smart device before you begin configuring the Night Owl HD 
CMS software .

*Image used for reference is of an iPad.

This is the P2P ID you 
will input in the Add a 
Device’s IP/ID field .

You will use your Apple or Android smart device (iPad is used in the above image) 
to scan the QR Code on your DVR or NVR . The information which populates the 
fields on the new device screen on your smart device is the same information you 
will enter into the Night Owl HD CMS “Add Device” screen . The password will be 
the same as the one used to configure your DVR/NVR .

If you choose not to configure the Night Owl HD app on a smart device before 
configuring the Night Owl HD 
CMS software on your PC you 
must log into your DVR or 
NVR to acquire the needed 
information .

With your HD app configured, 
or with the required information 
gathered from your DVR/NVR, 
please click on the “Add Device” 
tab within the Setup Wizard .

Night Owl HD CMS Guide How Do I Add a Device to Night Owl’s HD CMS Software?
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Once the connection is verified, these red dots will turn green . Please keep in 
mind it may take up to two minutes for the connection to be verified .

A group name can be changed by clicking on the Modify tab and then entering the 
new group name . Click on “Yes” to save the new name .

In order to import the recently added device to a group, simply choose the device 
you wish to import, select the proper group and then click on “Import” .

The device (DVR or NVR) will now appear under that group .

Night Owl HD CMS Guide How Do I Add a Device to Night Owl’s HD CMS Software?
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You can view the amount of channels connected to the device (DVR or NVR) by 
left clicking on the arrow next to the device image . In order to view your security 
system you will left click on the “Control Panel” icon .

Select the “Main View” icon.

In this example we have the group renamed as “Any Group Name” .

Left click on the device (DVR or NVR) while dragging the device into the main 
viewing area .

Night Owl HD CMS Guide How Do I Add a Device to Night Owl’s HD CMS Software?
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You should now see Live Video feed from the cameras connected to the selected 
device (DVR or NVR)

Left to Right:

Allows you to stream video .

Allows you to view the current viewing layout in full screen mode . To exit 
full screen mode you will right click anywhere on screen and then select 
Exit full Screen from the dropdown menu .

Allows you to select multiple viewing layouts . Keep in mind you can view 
a maximum of 128 channels simultaneously if you have multiple devices 
(DVRs or NVRs) configured on this software .

Allows you to stop all video from being displayed .

Allows you to record video directly to your PC . Select the icon once 
to indicate the start of the recorded video, a red “R” will appear that 
indicates the recording has started . Then select the icon again to indicate 
the end of the recorded video . The video file will be stored to your C drive 
on your computer, in the Night Owl HD CMS folder .

Allows you to save snap shot images directly to your PC . The images will 
be saved in the C drive in the Night Owl HD CMS folder . 

Allows you to go to the previous viewing screen .

Allows you to go to the next viewing screen .

Allows you to configure the sequence mode controls . If you enable this 
your channels will be displayed in sequential order and stay on screen 
before going to the next screen for the time duration you specify . 

Allows you to mute all audio . Keep in mind not all cameras are audio 
enabled and this tab will have no function if your camera is not audio 
enabled . 

Night Owl HD CMS Guide How Do I Add a Device to Night Owl’s HD CMS Software?
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How Do I Remotely 
View My System?

To view Playback Recordings:
1 . Select the group, the DVR, and the channels whose recordings you wish to 

view .

2 . Select “File Type”, either “Continuous” or “Alarm” .

3 . Choose “Synchronous Playback” if you wish for the selected channels to be 
played on the monitor simultaneously .

4 . Whichever days on the calendar have recordings for the channels selected will 
have an orange triangle .

5 . Then select the date you wish to choose and left click “Search” . 

1

4

2

3

5

Within the Control Panel, click on the Remote Playback icon . From there simply 
follow the steps and direction below to access your recordings .

 6 . The recordings for the selected date will appear as yellow markings in the 
appropriate window (window numbers correlate directly with channel number) . 
Yellow recordings will be placed under the time they were recorded . 

 7 . Click the “Play” button to begin playing the recording .

 8 . Click the “Pause” button to pause the recording .

 9 . Click on the “Stop” button to stop the recording . 

 10 . Click the “Back” button to slow the playback speed .

 11 . Click the “Forward” button to speed up the playback speed .

 12 . Click the “Screen” button to proceed through the recording screen by screen .

7 8 9 10 11 12 6

Night Owl HD CMS Guide How Do I Remotely View My System?
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13 . Click on the “Zoom” icon to zoom in on the recording .

 14 . Click on the “Capture” icon to take a picture of an image that appears in the 
recording . These images can be accessed in File Management .

 15 . Click on the “Recording” icon to take a shorter recording of something in the 
initial recording . These recordings can be accessed in File Management .

 16 . Click on the “Audio” icon to stop or resume sound . 

 17 . Click on the “Download” icon to download the recording and save it to your 
computer . 

13 14 15 16 17

How Do I Perform a 
Local Log Search?

1 . User Name allows you to switch users .

2 . Log Type allows you to choose to view the Alarm Log, Operation Log or  
System Log . 

3 . Minor Type allows you to further narrow down your search by specific  
content type .

4 . The Group drop down menus allow the user to choose between different  
DVRs and multiple channel groupings . 

5 . The Start Time and End Time drop downs allow the user to choose the date 
and time range of the impending search . 

6 . A copy of each log can be backed up to your hard drive and those logs can be 
accessed from this screen .

1

2

3

4 5 6

Night Owl HD CMS Guide How Do I Perform a Local Log Search?



22 23

The Alarm Log will pull up a log of all alarms for the selected date range . The log 
will contain the date and time of the alarm, the content, the user name (for those 
with multiple DVRs interconnected), the group name, group device name and the 
channel the alarm was triggered on . The Minor Type menu can be used to narrow 
down the search parameter as well .

The Operation Log is a log of all activity occurring via use of the surveillance 
software . As is the Alarm Log, the Operation Log is readily categorized to make 
searching simple . The Minor Type menu can be used to narrow down the search 
parameter as well .

The System Log is a log of all user logins, logoffs, locks and unlocks . As are the 
other two logs, this log is simple to search and readily categorized . 

Night Owl HD CMS Guide How Do I Perform a Local Log Search?
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Why Use Account Management?

The Account Management Tab allows the user to add new accounts and modify 
account settings . To modify, simply click on the account you wish to modify, then 
select the modify tab . The Modify User box will pop up, and upon entering the 
correct password the user can adjust the displayed settings . 

Why Use File Management?

File Management provides the user access to captured images and recordings 
taken from both Live View mode and those taken while viewing recordings . Simply, 
1, choose the channel you captured the image or recording on then, 2, select 
either Picture (for captured images) or Video (for captured recordings) . 

Then, 3, choose whether to view Selected (current) or Deleted items and 4, 
select the target date and time range . Then simply hit the search tab, 5, and all 
available images or recordings for the specified range will appear .

1

2

3
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Why Use System Configuration?

Under the General Tab in System Configuration, the user can access the language 
settings, adjust the time frame the logs are stored (choosing between one week, 
half a month and one month), enable audio on multiple channels simultaneously, 
enable auto- login and resume live view status . 

Under the File Tab, users can easily adjust where captured videos and pictures 
are stored in their computer . In addition, the user can set an alarm to go off when 
disk space reaches a specified level . 

Under the Alarm Sound Tab, users can adjust the alarm sounds for motion 
activation, video exception and alarm input with sounds stored on their computer . 

Night Owl HD CMS Guide Why Use System Configuration?
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